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ВСТУП


В останні роки проблема електромагнітної сумісності різних пристроїв РЕА перетворилася на самостійний науково-технічний напрям, що охоплює численні аспекти радіотехніки, електроніки і електротехніки. ЕМС повинна враховуватися на кожному етапі розробки і виготовлення технічних засобів : системотехнічному, конструкторсько-технологічному і виробничому, а також на етапі експлуатації.

Практичне рішення проблеми ЕМС приводить до підвищення якості РЕА.  Пристрій не можна вважати якісним, якщо він, виконуючи своє призначення, створює електромагнітні перешкоди, які не дають іншім пристроям виконувати своє призначення. Також не можна вважати якісним будь-який пристрій, якщо він у відсутності перешкод виконує своє призначення і не виконує його за наявності перешкод навіть допустимого рівня.

Для РЕА проблема ЕМС розглядається в двох аспектах:

 - захист від зовнішніх перешкод;

 - захист від внутрішніх перешкод (електронне конструювання).

У даному дипломному проекті досліджуються сучасні методи захисту пристроїв від внутрішніх перешкод за допомогою введення додаткових шарів металізації у друковані плати. У якості досліджуємого об’єкту було обрано блок комбінований БК-2075, що призначений для перетворення сигналу від первинного або нормуючого перетворювача в уніфікований вихідний електричний сигнал постійного струму або напруги і цифровий сигнал. Необхідно проаналізувати найбільш чутливі лінії зв’язку цього блоку на предмет наявності неузгодженості та запропонувати методи подолання небажаних перешкод виникаючих при протіканні струмів через задані лінії зв’язку.

1 УКЛАДАННЯ ШАРІВ У БАГАТОШАРОВИХ ДРУКОВАНИХ ПЛАТАХ
1.1 Проектування шарів живлення і землі

Укладання шарів друкованої плати встановлює послідовність розташування шарів друкованих доріжок, які з них повинні бути суцільними шарами живлення та землі, величину діелектричної проникності підкладки і відстань між друкованими шарами. При проектуванні укладання шарів також розраховуються необхідні розміри друкованих доріжок і мінімальна ширина проміжків між ними.


На конструкцію багатошарової друкованої плати сильно впливає технологія її виготовлення. Як правило, чим вище щільність розміщення друкованих доріжок, тим вище питома вартість виготовлення друкованої плати (у перерахунку на одиницю площі плати). 
Нижче розглянуті основні правила проектування багатошарових друкованих плат.


Для того щоб спроектувати систему живлення і прив'язки до землі необхідно перш за все задати такі параметри, як тривалість фронтів сигналів, кількість сигнальних ліній і геометричні розміри друкованої плати [8, 9].


Задамо, в числі інших геометричних параметрів, і орієнтовну ширину друкованих доріжок. На першому етапі проектування плати точне значення ширини друкованих доріжок не має особливого значення.



Далі оцінимо величини власної та взаємної індуктивності друкованих сигнальних ліній для варіантів суцільного шару землі, а також решітчастої і гребінчастої структури шин землі. На цьому етапі, як правило, з'ясовується, який з типів системи прив'язки до землі задовольняє технічним вимогами. Нагадаємо, що у разі гребінчастої  структури шин землі всі сигнальні лінії роблять вплив один на одного. У разі решітчастої структури шин землі взаємний вплив один на одного надають тільки ті сигнальні лінії, які проходять в одному проміжку між координатними друкованими доріжками решітчастої структури, а в разі суцільного шару тільки сусідні сигнальні лінії роблять взаємний вплив один на одного.


Якщо потрібно закласти в конструкцію друкованої плати суцільний шар землі, необхідно закладати суцільні опорні шари парами, симетрично розташованими по товщині укладання плати. Симетричні пари суцільних металізованих шарів в багатошаровій друкованій платі перешкоджають викривленню друкованої плати. У разі одиночного суцільного шару металізації, розміщеного не по центру укладання шарів, виникає значне викривлення друкованої плати.



Шари живлення, аналогічно шарам землі, можуть використовуватися в якості шляху найменшої індуктивності для зворотних струмів сигналів. При включенні між шарами землі та живлення достатньої кількості блокувальних конденсаторів лінії передачі, прокладені над шаром живлення, працюють так само добре, як і лінії, прокладені над шаром землі. Полоскові лінії передачі, прокладені між шарами живлення та землі або між двома шарами живлення, також працюють нормально.


1.2 Вибір геометричних розмірів друкованих доріжок


Підвищення щільності компонування схеми забезпечується, як правило, за рахунок підвищення щільності трасування доріжок на друкованій платі. При дуже щільному компонуванні знижується кількість необхідних шарів плати. Оскільки вартість друкованої плати пропорційна кількості шарів і площі плати [10], необхідно прагнути розробити надійно функціонуючу друковану плату з мінімально можливою кількістю шарів.



Але зменшення ширини друкованих доріжок і ширини проміжку між ними призводить також до зростання перехресних перешкод і зниженню допустимого струмового навантаження друкованих доріжок. Для зниження вартості друкованої плати надзвичайно важливо знайти правильне компромісне рішення між рівнем перехресних перешкод, щільністю трасування і допустимого струмового навантаженням.



У першу чергу розберемося з допустимим струмовим навантаженням друкованих доріжок, оскільки це обмеження є самим явним і зрозумілим. Допустиме струмове навантаження друкованої доріжки залежить головним чином від площі її поперечного перерізу і допустимого перевищення температури друкованого провідника щодо температури навколишнього середовища. При заданій площі поперечного перерізу величина перевищення температури друкованій доріжки щодо температури навколишнього середовища зростає приблизно пропорційно величині розсіюється нею потужності. Значне нагрівання друкованих доріжок викликає зниження надійності і нагрівання сусідніх ланцюгів цифрової схеми. Безпечним, з точки зору надійності роботи схеми, гранично допустимим перевищенням температури друкованої доріжки щодо температури навколишнього середовища в цифровий апаратурі є 10 ° С.



На рисунку 1.1 наведені графіки для розрахунку температури нагріву друкованої ріжки залежно від прикладеної до неї струмового навантаження. По горизонтальній осі координат відкладена площа поперечного перерізу друкованої доріжки, виражена в квадратних дюймах. По вертикальній - сила струму в амперах.
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Рисунок 1.1 – Допустиме струмове навантаження залежно від площі поперечного перерізу друкованого провідника

За винятком шин розподілу живлення, які повинні витримувати великі струми, потужність рідко виявляється серйозною перешкодою. Однак у міру розширення застосування тонкоплівкової технології, що дозволяє виготовляти друковані провідники надзвичайно малого поперечного перерізу, обмеження по струмового навантаження можуть перетворитися на більш серйозну проблему. Другим нижнім обмеженням на допустиму ширину друкованих доріжок є технологічні можливості виробництва. Незалежно від використовуваної технології виготовлення друкованих плат, у міру зменшення ширини друкованих провідників до гранично допустимого значення відсоток виходу придатних виробів знижується, а вартість виготовлення - зростає Цей фактор, в більшості випадків, утримує розробників від використання друкованих доріжок гранично допустимої мінімальної ширини.


Є й інші чинники, які змушують збільшувати ширину друкованих провідників. Нестабільність технологічних параметрів процесу травлення призводить до значної нерівномірності ширини друкованих доріжки по довжині. У разі вузьких друкованих доріжок допуск на відносний розкид ширини по довжині друкованої доріжки, який визначає відносний розкид хвильового опору друкованої лінії по її довжині, може виявитися недосяжним. Необхідність забезпечення високої рівномірності хвильового опору змушує використовувати друковані доріжки шириною, що набагато перевершує гранично досяжне мінімальне значення.


Для визначення співвідношення між шириною і висотою підйому друкованої доріжки над опорним шаром, досить високого для забезпечення заданої точності дотримання хвильового опору, при встановлених допусках на ширину друкованої доріжки і товщину підкладки, можна використовувати методики, наведені в [10]. При розрахунку допуску на хвильовий опір друкованої лінії необхідно обов'язково враховувати розкид за величиною діелектричної проникності підкладки.


Обмеження по струмовому навантаженню, вартості та точності дотримання хвильового опору визначають, як правило, конкретне значення ширини друкованих доріжок. При обраної ширині друкованих доріжок, товщина підкладки визначається, виходячи з заданого значення хвильового опору друкованих ліній передачі.

1.3 Зв'язок між щільністю трасування і кількістю необхідних шарів друкованих провідників


Чим більше кількість шарів друкованих провідників, тим ширше можна рознести друковані доріжки один від одного. Це полегшує трасування і знижує ризик виникнення проблеми перехресних перешкод. На жаль, вартість багатошарової друкованої плати зростає пропорційно добутку кількості шарів площу плати. Чим більше шарів, тим вище вартість друкованої плати.


При зменшенні кількості шарів доводиться звужувати крок друкованих доріжок що також викликає підвищення вартості виготовлення друкованої плати. Але крім цього, при досить вузькому кроці друкованих доріжок зростає небезпека того, що рівень перехресних перешкод виявиться занадто високим.


Визначити ту мінімальну кількість шарів, при якому вартість виготовлення друкованої плати виявиться мінімальною, можна, тільки спираючись на досвід і міркування якісного характеру. Головним питанням є правильна оцінка кроку доріжок, що вимагається для прокладки N з'єднань на платі певних розмірів, що складається з М шарів друкованих провідників. Знаючи крок друкованих доріжок, можна оцінити вартість виготовлення друкованої плати і одночасно розрахунковий рівень перехресних перешкод.


Крок друкованих доріжок визначається щільністю трасування. Одна з корисних моделей для розрахунку щільності трасування носить назву правила Рента (Rent) [1] - по імені інженера компанії IBM, вперше сформулювавши його Рент звернув увагу на те, що в більшості випадків для друкованих плат великої площі характерно наступне: якщо розбити, друковану плату навхрест на чотири рівні частини, то тільки половина друкованих з'єднань проходять в даному квадранті, переходить через його кордон в інші квадранти, а половина - ні. При подальшому розподілі частин друкованої плати на менші частини така особливість зберігається. Гелі припустити, що довжина друкованих провідників у середньому дорівнює відстані між квадрантами, на які розбита друкована плата, то з цього вельми умоглядного припущення можна отримати наступну оцінку середньої довжини друкованих провідників, усередненої по всій друкованій платі - вона становить три восьмих розміру плати.



Знаючи середню довжину друкованих провідників і їх кількість, можна розрахувати загальну площу поверхні, що покривається ними для будь-якого значення кроку друкованих доріжок. Формула 1.1, отримана виходячи з правила Рента, дозволяє розрахувати крок друкованих провідників, необхідний для трасування N з'єднувальних провідників на платі заданого розміру, що складається з М шарів друкованих провідників.
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де N — кількість друкованих з'єднань (передбачається, що їх розподіл підкоряється правилу Рента);
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 — середній крок друкованих доріжок, дюйми;


X — ширина плати, дюйми;


Y — висота плати, дюймы;


М — кількість шарів друкованих провідників.


Звичайно, якщо є яка-небудь конкретна інформація, що стосується технічних вимог на трасування, наприклад, інформація про великі шини або інших структурах, її потрібно використовувати, У відсутність будь-якої конкретної інформації про особливості схеми для оцінки необхідного кроку доріжок можна скористатися ідеєю Рента.


Для плат з скрізними отворами оцінка середнього кроку, отримана за формулою 1.1, і необхідний мінімальний крок друкованих доріжок дуже сильно відрізняються. Необхідність використання дводоріжкового або трьодоріжкового трасування друкованих провідників у просторі між виводами мікросхем визначається, виходячи з мінімально допустимого кроку друкованих доріжок, отриманого за результатами аналізу рівня перехресних перешкод. Для оцінки необхідного запасу вільних друкованих доріжок потрібно використовувати величину середнього кроку друкованих доріжок, отриману за формулою 1.1.


У внутрішніх шарах друкованих провідників плат поверхневого монтажу може бути більше вільного місця для прокладки друкованих доріжок, в порівнянні з платами під DIP-корпуси. Загальна кількість міжшарових перемичок в обох варіантах плат буде приблизно однакова, але розміри скрізних металізованих отворів міжшарових перемичок в платах поверхневого монтажу менше, оскільки вони не призначені для установки виводів мікросхем. У плат поверхневого монтажу середній і мінімальний крок друкованих доріжок у внутрішніх шарах можуть мати близькі значення.


У внутрішніх шарах друкованих плат з підкладками з склотекстоліта між отворами під виводами елементів можна, в принципі, умістити до чотирьох друкованих доріжок, але це може привести до серйозних проблем, викликаним високим рівнем перехресних перешкод.


Додатковий простір на платі для прокладки друкованих з'єднань може бути забезпечено за рахунок менш щільного компонування мікросхем на платі, але при цьому зросте загальна площа друкованої плати. Розробники вважають за краще, як правило, нарощувати кількість шарів.


Якщо виникає проблема перехресних перешкод, потрібно використовувати такий варіант трасування, щоб друковані доріжки щільно зближувалися один з одним тільки в просторі між виводами мікросхем, а потім відразу ж розходилися в сторони, поки їм не зустрінеться наступна мікросхема. Для цього доведеться виконати великий обсяг ручної корекції, але навіть невелике розширення проміжків між друкованими доріжками забезпечує ослаблення перехресних перешкод.

1.4 Класичні варіанти укладання шарів

На рисунках 1.2 - 1.4 наведені три класичні варіанти укладання шарів для 4, 6 і 10 шарів. Ці варіанти укладання розроблені під стандартну технологію виготовлення багатошарових друкованих плат з склотекстоліту, опис якої наводиться нижче. При кількості шарів більше 10 розробники зазвичай закладають в плату додаткові опорні шари землі з метою екранування груп шарів друкованих провідників один від одного.

Наведені варіанти укладання шарів підходять для друкованих плат швидкодіючих комп'ютерних вузлів, що розміщуються в екранованих корпусах. Для друкованих плат пристроїв, які гарантовано повинні відповідати за рівнем електромагнітного випромінювання нормам FCC, VDE, Tempest чи іншим законодавчо встановленим нормам, без використання добре екрануючих корпусів, ці прості варіанти укладання шарів не підходять.
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Рисунок 1.2 – Укладання шарів чотиришаровій друкованої плати

Позначення «горизонтальне трасування» і «вертикальне трасування» на всіх рисунках означають, відповідно, вертикальну або горизонтальну орієнтацію друкованих доріжок в конкретному шарі друкованих провідників. Традиційно прийнято прокладати друковані доріжки в одному шарі паралельно один одному. У кожному наступному шарі друковані доріжки повернені під прямим кутом по відношенню до орієнтації друкованих доріжок у нижньому шарі. Тільки деякі доріжки прокладаються по діагоналі шару плати або мають довгі вигини під прямим кутом.
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Рисунок 1.3 – Укладання шарів шестишарової друкованої плати

При такій орієнтації друкованих доріжок зростає ефективність трасування.
Шари живлення та землі на рисунках 1.1 - 1.4 виділені товстими суцільними лініями. Рисунки виконані з дотриманням масштабу між шириною зображених на них друкованих доріжок і висотою їх підйому над суцільними опорними шарами.
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Рисунок 1.4 – Укладання шарів десятишарової друкованої плати

Терміни основа і препреги означають матеріали, використовувані в технології виготовлення багатошарової друкованої плати. Нижче наводиться короткий опис однієї з широко застосовуваних технологій виготовлення друкованих плат [10]. При необхідності жорсткого дотримання заданої висоти підйому друкованих провідників над суцільними шарами землі потрібно знати властивості матеріалів основи препрега.

1.5 Технологія виготовлення друкованих плат



Процес виготовлення багатошарової друкованої плати починається з того, що береться комплект заготовок з двостороннього фольгованого діелектрика. У шарах мідної фольги, призначених для внутрішніх шарів друкованих провідників, витравляється малюнок друкованих доріжок. Шари мідної фольги, призначені для зовнішніх шарів, залишаються недоторканими. Такі заготовки діелектрика з витравленим в покривають їх шарах міді малюнком друкованих доріжок називаються основою. Відстань між шарами друкованих доріжок, що покривають з обох сторін діелектричну підкладку основи, залежить від її товщини. Потім основи укладають в заданому порядку один на одного, прокладаючи між ними препреги, що представляє собою діелектричну основу, просочену частково знедоленою епоксидною смолою. У процесі гарячого пресування відбувається розм'якшення і полімеризація смоли, в результаті чого шари основи склеюються з препрегом. Товщина перепрега після такої обробки визначає відстань між шарами друкованих провідників, між якими він прокладений. Препреги, полімеризуючись, перетворюється на твердий шар склотекстоліта, що має ту ж діелектричну проникність, що і основа. В укладанні багатошарової друкованої плати шари основи і препрега чергуються один з одним.


Оскільки препреги частково розм'якшується в процесі гарячого пресування, шари друкованих доріжок, прилеглі до нього з обох сторін, вдавлюються в розм'якшений матеріал препрега, що володіє клеючими властивостями. При точному аналізі відстані між шарами друкованих доріжок і шарами землі необхідно враховувати, що, з урахуванням вдавлення шарів друкованих доріжок у препрег, відстань між зверненими один до одного сторонами доріжок, прилеглими до препрега з обох сторін, стає меньше товщини препрега на подвоєну товщину доріжок. Суцільні опорні шари металізації у матеріалі препрегу не вдавлюються. Залежно від особливостей використовуваної технології виготовлення друкованої плати в якості зовнішнього шару друку використовується шар мідної фольга з одного боку основи, який був залишений недоторканим при травленні, або ж шар фольги, що приклеюється до зовнішньої сторони препрегу в процесі пресування друкованої плати. У будь-якому випадку зовнішній шар являє собою суцільний шар міді (що ще не піддавався операції травлення).


Після полімеризації препрега в отриманій багатошаровій структурі свердлять отвори. Через просвердлені отвори відкривається доступ до друкованих провідників, розташованих у внутрішніх шарах плати, і контактним майданчикам, крізь які проходять отвори, але вони поки ще залишаються електрично ізольованими один від одного.


Далі проводиться хімічне осадження шару міді на стінки отворів і одночасно на зовнішню поверхню друкованої плати. З метою скорочення витрати матеріалу та тривалість цієї операції, перед її виконанням на зовнішню поверхню друкованої плати, як правило, наноситься захисна маска, що покриває всю поверхню плати за винятком малюнка друкованих доріжок закладених в трасування плати, і майданчиків навколо отворів, просвердлених в платі. Після цієї операції товщина друкованих доріжок у зовнішньому шарі фольги стає дещо більше вихідної товщини мідної фольги. Саме цей приріст товщини служить причиною збільшення нерівномірності ширини друкованих провідників, виконаних у зовнішніх шарах, в порівнянні з внутрішніми шарами.

Завершує процес виготовлення друкованої плати травлення малюнка друкованих провідників в зовнішніх шарах металізації. Після цього провідники зовнішних шарів плати покриваються припоєм (якщо це закладено в технічні вимоги паяльною маскою і на поверхню з обох сторін плати методом шовкографії наноситься маркування.

2 АНАЛІЗ ЕЛЕКТРОМАГНІТНОЇ СУМІСНОСТІ ТОПОЛОГІЇ ДБП
2.1 Параметри топології блоку комбінованого  БК-2075

Блок комбінований БК-2075 призначений для перетворення сигналу від первинного або нормуючого перетворювача в уніфікований вихідний електричний сигнал постійного струму або напруги і цифровий сигнал.

Для аналізу перехідних процесів у ланцюгах блоку БК-2075 використаємо лінії UN000008, UN000009 та UN000010. Топологія ланцюга UN000008 представлена на рисунку 2.1. Даний ланцюг з’єднує мікросхеми D1, D4 та D10. Топологіі ланцюгів UN000009 та UN000010 представлені на рисунку 2.2. Ланцюг UN000009 з’єднує мікросхеми D1 та D10, а ланцюг UN000010 мікросхеми D4 та D10. Параметри та призначення з’єднуваних мікросхем:

· D1 та D4 однакові – ADG621 [12] здвоєні монолітні CMOS перемикачі. Кожен вимикач ADG621 проводить однаково добре в обох напрямках. У ADG621 обидва вимикачі нормально відкриті. Параметри ADG621 представлені у таблиці 2.1;

· D10 MSC1210 [13] 24-бітний прецизійний АЦП з 8051 мікроконтролерним ядром і Flash пам'яттю Параметри MSC1210 представлені у таблиці 2.2.
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Рисунок 2.1 – Топологія ланцюга UN000008
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Рисунок 2.1 – Топології ланцюгів UN000009 та UN000010

Таблиця 2.1 – Електричні характеристики мікросхеми ADG621 (D1, D4)

	Параметр
	Значення

	Вхідна напруга логічного нуля, U0вх, В
	0,8 max

	Вхідна напруга логічної одиниці, U1вх, В
	2,4 min

	Вхідна ємність Cin, пф
	2

	Вхідний опір, Rвх, Ом
	3(108


Таблиця 2.2 - Електричні характеристики мікросхеми MSC1210 (D10)

	Назва параметра
	Значення

	Вихідна напруга логічного нуля, U0вих, В
	1,5 max

	Вихідна напруга логічної одиниці, U1вих, В
	3,5 min

	Вихідна  ємність Cout, пф
	8

	Вихідний опір, Rвих, Ом
	200


Мікросхеми D1 та D4 у досліджуваних ланцюгах працюють лише як приймачі сигналів тому у таблиці 2.1 зазначені лише вхідні параметри, а мікросхема D10 відповідно працює, як передавач сигналів тому у таблиці 2.2 зазначені вихідні параметри.

2.2 Структура і функції систем аналізу ЕМС РЕА

Для проведення аналізу електромагнітної сумісності багатошарових планарних топологій (багатошарові друковані, об'єднувальні панелі, мікрозбірки і полоскові лінії) широкого поширення набув пакет SIX (Signal Integrity + Xtalk) [11].
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Рисунок 2.3 - Структура системи аналізу ЕМС багатошарових топологій.

1 - САПР проектування багатошарової топології (файли*.рсв);

2 - інтерфейс бази даних пакету SIX з файлами *.рсв САПР проектування топології;

3 - програмний модуль (Signal Integrity) аналізу перехідних процесів в електрично довгих ланцюгах;

4 - хвилевий аналізатор (Wave Analyzer) відображує результати моделювання перехідних процесів і перехресних наведень в електрично довгих ланцюгах;

5 - програмний модуль (Xtalk) аналізу перехресних наведень в електрично довгих ланцюгах;

6 - редактор бібліотеки (Macromodel Editor) IBIS - моделей ЕРЕ;

7 - призначена для користувача і базова бібліотеки IBIS - моделей ЕРЕ.


Пакет SIX забезпечує рішення наступних завдань.


1. Інтерфейс формату даних - файл *.рсв опису багатошарової планарної топології і пакету SIX. Обчислюються для виділених ланцюгів їх хвилеві характеристики, представлені на рисунку 2.4.

[image: image10.jpg]S| B 586 | Bl o8] v

a No | et [ Length [.. | Average Inp. [0... | _Comment
+ unoone s

UN00000E 2 Dt c 9 n

UN000003 3 D4 1 B n

aoaoos

Ready





Рисунок 2.4 - Вікно моделювання довгих ланцюгів.


2. Моделювання перехідних процесів електрично довгих ланцюгів з обчисленням хвилевого опору, основних параметрів імпульсних сигналів [3]. Результати моделювання перехідних процесів відображуються у вікні хвилевого аналізатора (Wave Analyzer) у вигляді кольорових оцифрованих графіків і списку основних параметрів сигналів (рисунок 2.5), що характеризують перехідний процес в електрично довгих ланцюгах.
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Рисунок 2.5 – Графік сигналів на вході (тонка лінія) і на виході (товста лінія) довгої лінії
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Рисунок 2.6 - Інструментальна панель виміру параметрів сигналів.


За допомогою інструментальної панелі (рисунок 2.6) можна виконати наступні команди:


1 – Carts (перемикання екрану на графік сигналу);


2 – FFT (перемикання екрану на спектральну діаграму імпульсу);


3 – Rise Time (час наростання сигналу – передній фронт імпульсу);


4 – Fall Time (час спаду сигналу – задній фронт імпульсу);


5 – Minimum (мінімальне значення сигналу);


6 – Maximum (максимальне значення сигналу);


7 – Base Line (базова нижня лінія відліку);


8 – Top Line (верхня лінія відліку).


3. Побудова спектральних діаграм, що містять постійну і гармонійні складові (гармоніки) імпульсів (розкладання сигналу в ряд Фур'є) [3], виконується командою FFT (рисунок 2.6, поз.2). Результати  побудови спектральних діаграм представлені на рисунку 2.7.
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Рисунок 2.7 – Спектральна діаграма довгої лінії


4. Моделювання перехресних перешкод між двома ланцюгами - агресор (джерело перешкод) і жертва (приймач перешкод) [3]. Результати моделювання відображуються у вікні хвилевого аналізатора (Wave Analyzer) оцифрованими графіками і списком основних параметрів сигналів (рисунок 2.8), що характеризують взаємні наведення ланцюгів.
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Рисунок 2.8 - Перехресна перешкода і її параметри.


5. Ведення бібліотеки IBIS моделей ЕРЕ. Активні ЕРЕ (мікросхеми, транзистори та ін.) представлені описом вхідних і вихідних комплексних опорів (імпедансу). Пасивні ЕРЕ (резистори, конденсатори, індуктивності та ін.) в бібліотеці IBIS моделей представлені своїми параметрами.

2.3 Комп’ютерний аналіз ЕМС багатошарових планарних топологій РЕА

На рисунку 2.9 представлена схема комп'ютерного аналізу ЕМС багатошарових планарних топологій РЕА.


[image: image15]
Рисунок 2.9 - Схема комп'ютерного аналізу ЕМС багатошарових планарних 
топологій РЕА.

Нижче перераховані назви і призначення основних процедур схеми, представленої на рисунку 2.10.

1 - аналіз багатошарової планарної топології. Вибір передбачуваних ланцюгів агресорів.

2 - розпізнавання ланцюгів жертв по відношенню до ланцюгів агресорів за наступними ознаками:

а) мінімальній довжині паралельних ділянок провідників;

б) максимальному проміжку між найближчими паралельними провідниками.

Розпізнавання найближчих паралельних ланцюгів до заданого ланцюга виконується за два етапи. На першому етапі задаємо у вікні Options Configure параметри найближчих ланцюгів до заданої (рисунок 2.11).
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Рисунок 2.10 - Параметри налаштування програми розпізнавання найближчих паралельних ланцюгів до ланцюга агресора.

Max. Couple Distance - максимально можлива відстань між найближчими паралельними провідниками;

Min. Couple Length - мінімальна довжина паралельних ділянок провідників;

Ignore Stubs to - відведення провідників, що не враховуються.

На другому етапі командою Find Couplend Net визначаються найближчі паралельні ланцюги відповідно до параметрів, обумовлених в меню Options Configure (рисунок 2.10).

3 – визначення початкових даних (параметрів мікросхем і друкованого монтажу) для аналізу ЕМС. При аналізі багатошарової планарної топології для мікросхем, використовуваних в електрично довгих лініях як джерело або приймач сигналів, необхідно визначити по довідниках наступні параметри:

- амплітуду максимально допустимої перешкоди позитивної полярності на вході мікросхеми, U+доп, В;

- амплітуда максимально допустимої перешкоди негативної полярності на вході мікросхеми, U-доп, В;

- вхідна напруга логічного нуля, U0вх, В;

- вхідна напруга логічної одиниці, U1вх, В;

- вихідна напруга логічного нуля, U0вих, В;

- вихідна напруга логічної одиниці, U1вих, В;

- тривалість фронту tф, нс;

- вхідний опір, Rвх, МОм;

- вихідний опір, Rвих, Ом.

Інформація про друкований монтаж поступає в пакет SIX безпосередньо з САПР топології за винятком відносної діелектричної проникності EPS матеріалу підкладки друкованого монтажу, а також товщини діелектрика і товщини шару металізації. Останні параметри вводяться в пакеті SIX командою Edit > Layer Stack.

4 - Опис IBIS - моделей досліджуваних мікросхем.

5 - аналіз перехідних процесів в поодиноких лініях зв'язку і узгодження їх по входу і по навантаженню.

6 - аналіз і оптимізація перешкод в схемах РЕА.

7 - коригування топології за результатами моделювання: установка резистора, що узгоджує на вході електрично довгої лінії, що узгоджує навантаження на виході, включення в структуру топології екранних шарів.

2.4 Аналіз перехідних процесів у ланцюзі UN000008 блоку  БК-2075

На рисунку 2.11 представлений графік перехідного процесу сигналу ланцюга UN000008  до узгодження. На цьому рисунку товстою лінією представлений графік сигналу на виході ланцюга точка D1.9, а тонкою лінією - на вході точка D10.36, при подачі на вхід прямокутного імпульсу амплітудою 5 В. З рисунку 2.11 видно, що максимальне значення сигналу на виході становить 5,51 В. Ланцюг необхідно узгодити так, щоб максимальне значення сигналу на виході ланцюга UN000008 було рівним приблизно 5 В.
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Рисунок 2.11 – Графік перехідного процесу сигналу ланцюга UN000008

Для узгодження ланцюгів зазвичай використовуються додаткові начіпні елементи навантажень на вході або на виході ланцюгів. Найбільш поширені варіанти навантажень для узгодження ланцюгів представлені на рисунку 2.12.
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Рисунок 2.12 – Варіанти навантажень для узгодження ланцюгів


Для узгодження ланцюга UN000008 було використано два варіанти додаткових навантажень. На рисунку 2.13 а) відображено меню термінатора для узгодження по входу ланцюга UN000008 резистором номіналом 70 Ом,а на рисунку 2.13 б) меню термінатора для узгодження по виходу ланцюга UN000008 резистором номіналом 40 Ом і ємністю номіналом 60 пФ.
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Рисунок 2.13 – Меню термінатора для узгодження ланцюга по входу а) та по виходу б)

На рисунку 2.14 представлений графік перехідного процесу сигналу ланцюга UN000008 після узгодження по входу. Товстою лінією представлений графік сигналу на виході ланцюга, а тонкою лінією - графік сигналу на вході, при подачі на вхід ланцюга  прямокутного імпульсу амплітудою 5 В. Максимальне значення сигналу на виході ланцюга дорівнює 5 В.
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Рисунок 2.14 – Графік перехідного процесу сигналу після узгодження ланцюга по входу

На рисунку 2.15 представлений графік перехідного процесу сигналу ланцюга UN000008 після узгодження по виходу. Товстою лінією представлений графік сигналу на виході ланцюга, а тонкою лінією - графік сигналу на вході ланцюга, при подачі на вхід ланцюга прямокутного імпульсу амплітудою 5 В. Значення сигналу на виході дорівнює 5 В. 
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Рисунок 2.15 – Графік перехідного процесу сигналу після узгодження ланцюга по виходу

Існує можливість не використовувати додаткові навантажувальні елементи для узгодження ланцюгів, в цьому випадку для узгодження використовують окремі металізовані екранні шари землі та живлення. На рисунку 2.16 представлений графік перехідного процесу сигналу ланцюга UN000008 після підключення екранних шарів. Товстою лінією представлений графік сигналу на виході ланцюга, а тонкою лінією - графік сигналу на вході ланцюга, при подачі на вхід ланцюга прямокутного імпульсу амплітудою 5 В. Максимальне значення сигналу на виході ланцюга дорівнює 5 В. 


На рисунках 2.17 – 2.18 зображені спектральні діаграми перехідних процесів до узгодження і після узгодження екранними шарами. При детальному розгляді можна помітити що після узгодження значно починають знижатися складові гармоніки сигналу після 100 MHz. Вже двонадцята гармоніка майже в два рази менша за амплітудою після узгодження екранними шарами ніж до узгодження ланцюга.
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Рисунок 2.16 – Графік перехідного процесу сигналу після підключення екранних шарів


Загальна інформація отримана по результатах комп’ютерного моделювання ланцюга UN000008 приведена в таблиці 2.3.
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Рисунок 2.17 – Спектральна діаграма перехідного процесу до узгодження

Таблиця 2.3 Аналіз перехідних процесів в ланцюзі UN000008

	Назва параметра
	Значення параметра до узгодження
	Значення параметра після узгодження по входу
	Значення параметра після узгодження по виходу
	Значення параметра після підключення екранних шарів
	Значення заданого параметра

	Rise Time (Час наростання сигналу - передній фронт імпульсу), нс
	2,15
	3,15
	3,37
	3,31
	3,5

	Minimum (Мінімальне значення сигналу), В
	-0,48
	-0,07
	0,00
	-0,02
	-0,1

	Maximum (Максимальне значення сигналу), В
	5,51
	5
	5
	5
	5,1
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Рисунок 2.18 – Спектральна діаграма перехідного процесу після узгодження

2.5 Аналіз взаємних перехідних процесів у ланцюгах UN000009 та UN000010 блоку  БК-2075

На рисунку 2.19 представлений графік перехресних перешкод ланцюга агресора UN000009 на ланцюг жертву UN000010 до узгодження. Тонкою лінією представлений графік сигналу на виході ланцюга UN000009 агресора, а товстою лінією - графік сигналу на виході ланцюга UN000010 жертви, при подачі на вхід ланцюга UN000009 прямокутного імпульсу амплітудою 5 В.

[image: image26.jpg]v V==

unoaooos
o1

unoaoo1o
pas

Measwements

Wirimum: D4.3
t=17.00ns
Viin =051V

Masinun: D4.3
t=1517ns
Vimar =050V





Рисунок 2.19 – Графік перехресних перешкод ланцюга до узгодження

На рисунку 2.19 видно, що максимальне значення сигналу на виході ланцюга жертви  UN000010 становить 0,50 В, а мінімальне -0,51 В. Необхідно узгодити ланцюги агресора UN000009 та жертви UN000010 таким чином, щоб максимальне значення сигналу в точці не перевищувало 0,1 В, а мінімальне -0,1 В.


На рисунку 2.20 представлений графік перехресних перешкод ланцюга агресора UN000009 на ланцюг жертву UN000010 після узгодження по входу ланцюга агресора. На рисунку тонкою лінією представлений графік сигналу на виході ланцюга  агресора, а товстою лінією - графік сигналу на виході ланцюга жертви, при подачі на вхід ланцюга агресора прямокутного імпульсу амплітудою 5 В. Максимальне значення сигналу на виході ланцюга жертви стало рівним 0,29 В, а мінімальне -0,17 В На рисунку 2.21 а) приведено меню термінатора для узгодження по входу ланцюга агресора UN000009 перехресних перешкод на ланцюг жертву UN000010 резистором номіналом 80 Ом.
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Рисунок 2.20 – Графік перехресних перешкод узгодження по входу ланцюга агресора
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Рисунок 2.21 – Меню термінатора для узгодження ланцюга по входу а) та по виходу б)

Узгодження по виходу проводиться однаковими елементами для ланцюгів агресора та жертви –  резистором з опором 70 Ом та ємністю 40 пФ, меню термінатора для узгодження по виходу представлено на рисунку 2.21 б).


На рисунку 2.22 представлений графік перехресних перешкод ланцюга агресора UN000009 на ланцюг жертву UN000010 після узгодження по виходу ланцюга агресора. На рисунку тонкою лінією представлений графік сигналу на виході ланцюга  агресора, а товстою лінією - графік сигналу на виході ланцюга жертви, при подачі на вхід ланцюга агресора прямокутного імпульсу амплітудою 5 В. Максимальне та мінімальне значення сигналу на виході ланцюга жертви стало рівним 0 В. На рисунку 2.23 графік перехресних перешкод з узгодженням по виходу але вже для ланцюга жертви. Максимальне значення сигналу на виході ланцюга жертви в цьому випадку зросло до 0,13 В та мінімальне  до -0,08 В.
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Рисунок 2.22 – Графік перехресних перешкод узгодження по виходу ланцюга агресора
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Рисунок 2.23 – Графік перехресних перешкод узгодження по виходу ланцюга жертви

На рисунку 2.24 представлений графік перехресних перешкод ланцюга агресора UN000009 на ланцюг жертву UN000010 після підключення екранних шарів. Тонкоюо лінією представлений графік сигналу на виході ланцюга агресора, а товстою лінією - графік сигналу на виході ланцюга  жертви, при подачі на вхід ланцюга UN000009 прямокутного імпульсу амплітудою 5 В. Максимальне значення сигналу на виході ланцюга жертви стало рівним 0,06 В, а мінімальне -0,04 В.
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Рисунок 2.24 –  Графік перехресних перешкод після підключення екранних шарів

Значення перехресних перешкод виникаючих на ланцюзі жертви UN000010 отриманих по результатах моделювання зведено у таблицю 2.4.

Таблиця 2.4 Значення перехресних перешкод ланцюга жертви

	Варіант моделювання
	Umin, В
	Umax, В

	До узгодження
	-0,51
	0,50

	Після узгодження по входу ланцюга агресора
	-0,17
	0,29

	Після узгодження по виходу ланцюга агресора
	0
	0

	Після узгодження по виходу ланцюга жертви
	-0,08
	0,13

	Після підключення екранних шарів
	-0,04
	0,06

	Задане значення 
	-0,1
	0,1


3. Моделювання параметрів електричних сигналів

3.1 Системи моделювання параметрів

Завдання параметрів тестових імпульсних сигналів, відображення і аналіз реакції довгого ланцюга на дію тестового сигналу, побудова спектральних діаграм, узгодження навантаження довгих ланцюгів здійснюється системою електромагнітного моделювання планарних НВЧ структур типу: SIX(Signal Integrity+Xtalk), PCAD+SIX, Altium Designer +SIX .
Способі мінімізації перехресних зв’язків: коректування топології, узгодження навантаження ланцюгів та включення екранних шарів 

Після того, як буде в редактор PCB завантажений файл друкованої плати, необхідно виконати команду PCB>Utils>P-CAD Signal Integrity, в результаті дії якої появиться діалогове вікно P_CAD 2002 Signal Integrity (рис.3.1).
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Рисунок 3.1 - Вікно запуску пакету до загрузки інформації з PCB – файлу.

Наступним кроком є загрузка PCB – файлу (рис. 3.2) командою File>Get Nets.
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Рисунок 3.2 - Вікно запуску пакету після загрузки PCB – файлу.

4. Опис властивостей ЕРЕ, ланцюгів і структури шарів друкованої плати. За допомогою команди Edit>Components визначаються властивості ЕРЕ (рис. 3.3). 
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Рисунок 3.3 - Діалогове вікно Edit>Components.
Для всіх варіантів виконання настройка однакова – використовуються тільки інтегральні схеми D1 – D4, категорія IC (рис.3.3). 

5. Наступним кроком є визначення типів ланцюгів (сигнальні ланцюги – DATA, ланцюги землі і живлення – Supply) з використанням команди Edit> Nets (рис. 3.4).
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Рисунок 3.4 - Діалогове вікно Edit Nets.

Для всіх варіантів виконання настройка однакова (див. рис.3.4). 

Структура шарів друкованої плати задається командою Edit>Layer Stack (рис.3.5). 
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Рисунок 3.5 -  Діалогове вікно Edit Layer Stack.

У цьому вікні для кожного варіанту виконання необхідно задати параметри:

Height – товщина (мм) діелектрика друкованої плати;

EPSR – діелектрична  відносна проникність матеріалу друкованої плати.

На рис. 3.5. параметри задані.

3.2 Моделювання довгих ланцюгів
 Для моделювання довгих ланцюгів необхідно в лівій частині вікна (рис. 3.2) вибрати потрібні ланцюги і виконати команду Edit>Take Over. В результаті виконання цієї команди відкриється вікно моделювання (рис. 3.6). 
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Рисунок 3.6 - Вікно моделювання довгих ланцюгів.

В області Simulation відображається список ланцюгів (С2, А3), вибраних для заданого варіанту виконання, а також їх довжини і імпеданс (хвильові опори).
Визначити залежність хвильового опору від матеріалу друкованої плати, який характеризується відносною діелектричною проникністю (табл. 3.4). Для зміни діелектричній проникності необхідно за допомогою команди Edit>Layer Stack викликати діалогове вікно (рис. 3.5) і змінити значення параметра EPSR.
Побудувати оцифрований графік залежності хвильового опору (вертикальна вісь) від діелектричної відносної проникності EPSR матеріалу друкованої плати (горизонтальна вісь). Вказати по осях одиниці вимірювання. Графік побудувати з використанням пакету Excel.
3.3 Перехресні перешкоди у разі суцільних шарів землі


Величина перехресного зв'язку між двома провідниками залежить від їх взаємної індуктивності та взаємної ємності [6]. Зазвичай в каналах цифрового зв'язку індуктивний перехресний зв'язок за величиною не поступається ємнісному або навіть перевершує її, так що далі буде розглядатися головним чином механізм індуктивного перехресного зв'язку.


У відповідності з теорією, що лежить в основі механізму індуктивної перехресного зв'язку в ланцюгах з зосередженими параметрами, зворотні струми сигналів збуджують магнітні поля, які, у свою чергу, створюють перешкоди в провідниках схеми.


Амплітуда перешкоди пропорційна швидкості зміни сигналу, що створює її. Чим коротше фронти сигналу, тим більше амплітуда створюваної ним наводки.


Оскільки щільність зворотного струму і напруженість збуджуваного їм магнітного поля знижується відповідно до формули 3.1, можна припустити, що перехресна перешкода, обумовлена взаємною індуктивністю провідників, буде слабшати в міру збільшення відстані між провідниками (рисунок 3.7).
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Рисунок 3.7 – Поперечний розріз плати, на якому зображений механізм виникнення перехресного зв'язку між двома доріжками

Перехресна перешкода визначається в даному випадку як відношення виміряної амплітуди перешкоди до амплітуди ступеневого сигналу, що створює її. Постійна К залежить від тривалості фронту сигналу і довжини ділянки взаємодіючих доріжок. Вона завжди менше одиниці.


Ця гіпотеза може бути перевірена за допомогою простого експерименту. На рисунку 3.8 зображено дві друковані доріжки довжиною 26 дюймів, виконані на діелектричній підкладці з одностороннім фольгуванням. Відстань між осями друкованих доріжок становить 0,080 дюйма. Суцільний шар землі в даному макеті виконаний у вигляді мідного листа, притиснутого до діелектричній підкладці плати знизу. Це зроблено для того, щоб можна було змінювати висоту підйому друкованих доріжок над шаром землі, прокладаючи між діелектричної підкладкою друкованої плати та мідним листом діелектричні прокладки заданої товщини. У даному випадку, як і у випадку хвильового опору, співвідношення фізичних розмірів має більш важливе значення, ніж самі розміри. У даному випадку величина перехресною перешкоди визначається відношенням D / H. Змінюючи висоту підйому друкованих доріжок над шаром землі, ми можемо задавати відношення D / H.
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Рисунок 3.8 – Експеримент з вимірювання залежності величини взаємного зв'язку між доріжками від їх геометричних параметрів

На рисунку 3.9 наведені осцилограми перехресною перешкоди в точці D при ступінчастому вхідному сигналі амплітудою 3,5 В. Осцилограми наведені для висоти підйому друкованих доріжок над шаром землі, рівної 0,010, 0,020, 0,030 0,040 дюйма. Останній графік (самий більший імпульс перешкоди) відповідає випадку, коли суцільного шару землі взагалі немає.



Рисунок 3.9 – Перехресна перешкода при ступінчастому вхідному сигналі
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Рисунок 3.10 – Експериментальні дані по взаємному зв'язку друкованих доріжок

На рисунку 3.10 наведено графік залежності взаємної індуктивності від ставлення D / H, побудований за цим експериментальним даним. Розрахунок взаємної індуктивності виконаний за методом площ, який описаний в [номер книги зі списку літератури]. Метод площ дозволяє врахувати ефект зниження швидкості наростання ступеневої сигналу при зростанні індуктивності проводить контуру. Цей ефект проявляється на кривій перешкоди як розтягнення імпульсу перешкоди при високих значеннях коефіцієнта зв'язку [1].
4. ОХОРОНА ПРАЦІ ТА БЕЗПЕКА В НАДЗВИЧАЙНИХ СИТУАЦІЯХ
4.1 Аналіз потенційно небезпечних і шкідливих виробничих факторів проектованого об'єкта, які впливають на персонал

У цьому розділі дипломного проекту розглянемо умови виготовлення й умови експлуатації розробленого пристрою з урахуванням організації безпеки праці. Розроблений пристрій призначений для застосування в складі робочих станцій, експлуатованих при наступних кліматичних і експлуатаційних умовах:

- температура навколишнього середовища від +5 до +50 °C;

- робоча напруга живлення – 12В;

- споживана потужність - не більше 5Вт;

- швидкість зміни температури не більше 10 °C/год;

- відносна вологість повітря при тривалому впливі від 5% при температурі 15 °C до 90% при температурі 30°C (час впливу не менш 720 год);

- відносна вологість повітря при короткочасному впливі не менш 100 % при температурі 50 °C (час впливу не більше 2 год);

- барометричний тиск від 84 до 107 кПа. 

Каркас, у який вставляється пристрій, виконаний зі сталі 10 кп ГОСТ 16523-89. Для захисту обслуговуючого персоналу від поразки електричним струмом каркас заземлюється відповідно до ГОСТ 12.1.030-81. При роботі з РЕА людина також піддається небезпеці поразки електричним струмом. Відповідно до ГОСТ 12.1.013-81, приміщення для РЕА по ступеню небезпеки поразки людини електричним струмом відноситься до приміщень без підвищеної небезпеки.

Категорії ваги виконуваних робіт при виготовленні й експлуатації виробу встановлюються відповідно до ГОСТ 12.1.005-88. Умови виготовлення й експлуатації пристрою відносяться до 1-ої категорії - легкі фізичні навантаження. Цим стандартом регламентовано параметри температури навколишнього повітря, відносної вологості, щільності й швидкості руху повітряного потоку на робочому місці.

Відповідно до ГОСТ 12.0.003-74 «Небезпечні й шкідливі виробничі фактори» при обслуговуванні РЕА мають місце фізичні й небезпечні психофізичні й шкідливі виробничі фактори:

- небезпека поразки людини електричним струмом;

- підвищена або знижена рухливість повітря;

- підвищена або знижена вологість повітря;

- підвищений рівень електромагнітних полів у робочій зоні;

- відсутність або недолік природного світла;

- підвищена пульсація світлового потоку;

- розумова перенапруга;

- монотонність праці;

- емоційні перевантаження.

Відповідно до ГОСТ 12.0.002-75 безпека виробничих процесів забезпечується вибором технологічного процесу.

Технологія виробництва виготовлення пристрою складається з різних технологічних операцій: виготовлення деталей, складання їх, налагодження пристрою. Розглянемо перераховані вище технологічні операції. При механічній обробці матеріалів виникає ряд небезпечних і шкідливих виробничих факторів:

- частини, що рухаються, виробничого встаткування;

- різальні інструменти;

- висока температура поверхні оброблюваної деталі;

- стружка, пил, шум, вібрація.

Сучасна технологія виготовлення ДП складається з великої кількості операцій. При виготовленні ДП можуть виникнути наступні небезпеки:

- поразка електричним струмом;

- термоопіки й хімічні опіки;

- поразка шкірних покривів;

- отруєння;

- шум, вібрація;

- світлові впливи газорозрядних ламп.

Більшість речовин і матеріалів, застосовуваних при виготовленні ДП, є шкідливими й становлять небезпеку для здоров'я й життя людини. Шкідливі речовини і їхні пари можуть проникати в організм людини через органи дихання, шкіру, травний тракт.

Електричні з'єднання здійснюються пайкою. Технологія виробництва містить у собі видалення ізоляції й лудіння. При виконанні пайки на робітника можуть впливати наступні шкідливі й небезпечні фактори:

- запиленість і загазованість повітря робочої зони;

- влучення розплавленого припою на шкірний покрив;

- наявність елементів, що нагріваються, дотик до яких викликає опіки.

4.2 Заходи щодо техніки безпеки

Проектом передбачаються наступні заходи, які обумовлюють захист від поразки людини струмом при роботі з розроблюваним модулем:

- повне зняття напруги з електроустановок при монтажі й ремонті;

- ізоляція струмоведучих частин електроустановок;

- огородження електроустановок;

- застосування світильників загального освітлення з напругою живлення 220В, установлених на висоті не менш 2,5м від рівня підлоги.

Відповідно до ГОСТ 12.1.030-81, для захисту людей від поразки електричним струмом при дотику до металевих неструмоведучих частин, які можуть виявитися під напругою в результаті ушкодження ізоляції, передбачаються наступні заходи:

- захисне заземлення або занулення металевих частин електроустановок, які доступні для дотику людини й не мають інших видів захисту, що забезпечують електробезпеку;

- шина заземлення виконується провідником з опором 4Ом.

При виконанні технологічних операцій необхідно вживати наступних заходів по забезпеченню техніки безпеки:

- наявність захисного заземлення;

- установка захисного огородження для встаткування;

- неухильне дотримання інструкцій і правил по техніці безпеки;

- організація загальної й місцевої вентиляції;

- застосування індивідуальних засобів захисту (рукавички, окуляри, спецодяг).

Відповідно до ГОСТ 12.2.003-74 необхідно, щоб небезпечні ділянки встаткування мали захисні екрани або офарблювалися в яскраві кольори.

Відповідно до ГОСТ 12.1.009-76, для захисту людей від поразки електричним струмом при дотику до металевих не струмоведучих частин, які можуть виявитися під напругою в результаті ушкодження ізоляції, передбачається захисне заземлення металевих частин електроустановок, які доступні для дотику людини й не мають інших видів захисту, що забезпечують електробезпеку. 

Захисне заземлення - це електричне з'єднання із заземлюючим пристроєм металевих неструмоведучих частин електроустановки, які можуть виявитися під напругою внаслідок переходу на них напруги зі струмоведучих частин з метою забезпечення електробезпеки.

Для розрахунку приймаємо напругу живлення – 220В, споживана потужність - 240Вт, опір землі не повинен перевищувати, відповідно до ГОСТ 12.1.030 - 81, - 8 Ом.

Приймаємо ґрунт - суглинок, глибина заземлювача - 0,8 м. Вимір здійснювався при середній потужності.

Знаходимо розрахунковий питомий опір ґрунту по формулі:

ρрозр = ρвим * ψi , 
(4.1)

де  ρвим - обмірюваний питомий опір ґрунту;

ψi - кліматичний коефіцієнт, який враховує стан ґрунту під час вимірів.

ρрозр = 100 * 1,5 = 150 Ом*м.

Приймаємо опір струму розтікання природних заземлювачів Rе = Rи = Rз.д = 4 Ом, тому що природний заземлювач відсутній.

Визначаємо опір струму розтікання з одного заземлювача. Застосовуємо стрижневий заземлювач в поверхні ґрунту з параметрами:

d = 0,01м; l = 5 м,

Rз.1 = ((ρрозр/ 2 * ( * l) * ln (4 * l / d), 
(4.2)

Rз.1 = (150 / 2 * 3,14 * 5) * ln (4 * 5/0,01) = 36,3 Ом.

Визначаємо необхідну кількість паралельно з'єднаних заземлювачів:

n = Rз.1 / (Rи * ηе), 
(4.3)

де  ηе - коефіцієнт використання заземлювачів, що враховує їхнє взаємне екранування, ηе = 0,47.

n = 36,3 / (4 * 0,47) = 19,31.

Отриману кількість заземлювачів округляємо до цілого числа й приймаємо n = 20. 

Визначаємо довжину сполучної смуги й опір струму розтікання, її Rп приймаємо перетин смуги d = 48 мм2, довжину l = 5 м) по формулі 6.2:

 Rп = (150 / 2 * 3,14 * 5) * ln (4 * 5/0,000048) = 61,8 Ом.

Визначаємо еквівалентний опір струму розтікання штучних заземлювачів:

Rі = Rз.1 * Rп / (Rз.1 * ηn + R * n * ηе), 
 (4.4)

де ηn - коефіцієнт використання горизонтального електрода (смуги зв'язку) з урахуванням вертикальних електродів, ηn = 0,27.

Rі = 36,3 * 61,8 / (36,3 * 0,27 + 61,8 * 20 * 0,47) = 3,8 Ом.

Отримане в результаті розрахунку опір штучних заземлювачів не перевищує необхідного, тобто Rі < Rі (3,8 < 4).

Визначаємо еквівалентний опір заземлюючого пристрою:

Rз.е = Rе * Rі / ( Rе + Rі) < Rз.д, 
(4.5)

 Rз.е = 4 * 61,8 / ( 4 + 61,8) = 3,76 Ом.

Умова виконується, отже, доведене спрацьовування захисного заземлення.

4.3 Заходи, які забезпечують виробничу санітарію і гігієну праці

У виробничому приміщенні на організм і його працездатність впливають мікрокліматичні фактори. Мікроклімат виробничих приміщень визначаються сполученням температури, вологості й швидкості руху повітря, а також температури навколишнього середовища.
Роботи з виробництва проектованого виробу відповідно до ГОСТ 12.1.005-76 відносяться до категорії робіт - фізична робота середньої ваги IIб. Оптимальні норми температури, відносної вологості, і швидкості руху повітря в робочій зоні виробничих приміщень наведені в табл. 4.1.
Освітлення повинне забезпечувати чітку видимість розподілів на відлікових і контрольно-вимірювальних приладах і пристроях.

Розряд зорових робіт відповідає категорії III «г». Для даної категорії нормовані наступні параметри - КЕО=1,2 %, освітленість 400 лк при комбінованому освітленні й 200 лк при загальному освітленні.

Таблиця 4.1 - Оптимальні норми температури, відносній вологості й швидкості руху повітря в робочій зоні виробничих приміщень.

	Період року
	Категорія робіт
	Температура, оС
	Відносна вологість, %
	Швидкість руху повітря, м/с,

	Холодний і перехідний
	середньої ваги IIб
	17-19
	60-40
	не більше 0,3

	Теплий
	
	20-22
	60-40
	не більше 0,4


Важливу роль у виробничій санітарії грає правильно спланована система освітлення: знижується виробничий травматизм, створюються нормальні умови для роботи органів зору, підвищується працездатність організму.

У розроблюваному проекті пропонується використовувати змішане освітлення. У світлий час доби приміщення буде освітлюватися через віконні прорізи, в інший час доби буде використовуватися штучне освітлення.

Штучне освітлення створюється лампами накалювання або газорозрядних ламп. Штучне освітлення в робочому приміщенні пропонується здійснити з використанням люмінесцентних джерел світла у світильниках загального освітлення, оскільки люмінесцентні лампи мають високу світлову віддачу (до 75 лм/Вт і більше), тривалим терміном служби (до 10000 годин), спектральним складом випромінюваного світла близьким до сонячного. 

Природне освітлення забезпечується бічними прорізами. Площа бічного прорізу визначається по формулі:
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де  
[image: image44.wmf]S

O

 - площа світлових прорізів, м2;
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- площа підлоги приміщення, м2; 
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80 м2;
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- нормоване значення КЕО, 
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= 1,2 % ;
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- коефіцієнт запасу
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З

=1,4 для приміщень із особливим режимом по чистоті повітря при обслуговуванні світильників знизу із приміщення;
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0

- світлова характеристика вікон, 
[image: image52.wmf]h

0

=8,5, для відношення довжини приміщення до глибини рівного 2 і відносини глибини приміщення до його висоти від рівня умовної робочої поверхні до верху вікна рівного 1;
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- коефіцієнт затемнення вікон конфронтуючими будинками, 
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= 1 для окремо стоячого будинку;
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- загальний коефіцієнт світлопропускання;
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1

- коефіцієнт підвищення КЕО при бічному освітленні за рахунок відбитого світла 
[image: image57.wmf]r

1

= 1.1, при відношенні довжини приміщення до глибини рівному 2, середньозваженому коефіцієнті відбиття 0,4 і відношенні відстані розрахункової точки від зовнішньої стіни до глибини приміщення 0,5 ).

Загальний коефіцієнт світлопропускання визначається по формулі:
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де  
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1

- коефіцієнт світлопропускання матеріалу 
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 = 0,9;
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- коефіцієнт світловитрат у плетіннях 
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 = 0,7;
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3

- коефіцієнт світловитрат у несучих конструкціях 
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=0,8; 
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- коефіцієнт світловитрат у сонцезахисних пристроях 
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Загальне освітлення забезпечується газорозрядними джерелами. Використовується світильник ЛСП06, що містить 2 лампи. Використовуються лампи типу ЛДЦ, потужністю 40 Вт і світловим потоком 2200 лм.

Кількість використовуваних світильників визначається по формулі:
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де Е - нормована мінімальна освітленість, Е = 200 лк;

S - освітлювана площа, S = 80 м2;

Z - коефіцієнт нерівномірності освітлення, Z = 1,15;

К - коефіцієнт запасу, К= 1,4 (див. розрахунок площі бічного прорізу);

m - число світильників, m= 2;

U - коефіцієнт використання випромінюваного світильниками світлового потоку на розрахунковій площині, U = 0,6;

F - світловий потік однієї лампи, F=2200 лм.
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Виходячи з розрахунку, для освітлення передбачається, установити 10 світильників.

Схема розташування світильників представлена на рис. 4.1.
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Рис. 4.1 - Схема розташування світильників 

Висота приміщення 6 м. У приміщенні встановлена система приточно-витяжної вентиляції. Робочі місця, на яких здійснюються особливо шкідливі операції (травлення ДП, знежирення, пайка) обладнаються місцевими відсмоктувачами.

Як небезпечні фактори діючих на здоров'я людини є пари, гази й пил, які є в багатьох технологічних процесах. Джерелами шкідливих речовин можуть бути: вихідна сировина, проміжні операції, готові вироби, відходи виробництва. Для забезпечення безпеки проведемо розрахунок системи місцевої вентиляції.

Кількість необхідного повітря залежно від кількості шкідливих речовин, що виділяються, визначається по формулі:
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де L
[image: image74.wmf]мт

 -  кількість повітря, що видаляється з робочої або обслуговуючої зони приміщення місцевими відсмоктувачами, загальобмінною  вентиляцією й на технологічні або інші потреби, м/год
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;

Z -  кількість шкідливий речовин, що надходять у повітря приміщення, мг/год;
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м

-  концентрація шкідливих речовин у повітрі видаляється з робочої зони місцевими відсмоктувачами на технологічні або інші потреби, мг/м
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 ;
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ух

- концентрація шкідливих речовин у повітрі, що видаляється із приміщення, мг/м
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 ;
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 концентрація шкідливих речовин у повітрі, що подається в приміщення, мг/м.
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У якості місцевих відсмоктувачів при пайці застосовуються шарнірно-телескопічні відсмоктувачі прямокутної форми, установлювані у вертикальній площині стола. Для ручної пайки використовуються два монтажних столи. 

Кількість повітря, що відсмоктується, для прямокутних отворів з гострими крайками (м3 /с) визначається по формулі:
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де  S – площа усмоктувального отвору, м
[image: image83.wmf]2

 ;

Е – більша сторона прямокутного усмоктувального отвору, м (Е = 0,14
[image: image84.wmf]¸

 0,28 м);

Х – відстань від площини усмоктувального отвору до розглянутої зони пайки, (Х = 0,1
[image: image85.wmf]¸

 0,3 м); 


[image: image86.wmf]V

х

- швидкість руху повітря в зоні пайки, м/с.

Менша сторона прямокутного усмоктувального отвору визначається з оптимального співвідношення:
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Площа отвору дорівнює:

S = b
[image: image89.wmf]*

 E,

S= 0,1
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 0,3=0,03м2,


[image: image91.wmf](

)

ч

м

с

м

L

мт

/

2

,

205

/

57

,

0

2

7

,

0

2

,

0

3

,

0

7

,

7

03

,

0

3

3

4

,

1

63

,

0

=

=

×

×

×

×

+

=

.

Розрахунок показав, що кількість повітря, що відсмоктується, із зони пайки повинна бути дорівнює 0,57 м3/с при розмірах усмоктувального отвору 0,1
[image: image92.wmf]´

1 0,3 м.

Кількість повітря розраховується по формулі (4.9) залежно від кількості шкідливих речовин, що виділяються. Розрахунок здійснюється для половини гранично-припустимої концентрації олова й свинцю. Приймаємо: Z = 500 мг/год, Сn = 0, тоді:
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У такий спосіб дана система вентиляції забезпечить подачу й відсмоктування повітря в приміщенні ручної пайки зі змістом шкідливих речовин в обсязі, не перевищуючому гранично припустимого.

Для забезпечення вентиляції будемо використовувати відцентровий пиловий вентилятор ЦП-7-40№6, що буде встановлений на даху будинку. Вентилятор ЦП-7-40№6 має характеристики, наведені в табл. 4.2.

Для зниження виробничого шуму редуктори, вентилятори розміщують у звукоізолюючих кожухах, зубчасті колеса поміщають у масляні ванни, застосовують акустичні екрани, що відокремлюють одне робоче місце від іншого, засоби індивідуального захисту - навушники. 

Таблиця 4.2 - Технічні характеристики вентилятора ЦП-7-40№6

	Найменування параметра
	Значення

	Продуктивність, м3/год
	5000

	Частота обертання, об/хв
	1755

	Тип електродвигуна
	4А132S4

	Потужність електродвигуна, кВт
	7,5


Підлоги на робочих місцях виконуються теплими, щільними, стійкими до удару; вони повинні мати неслизьку й зручну для чищення поверхню; так само бути стійкими до хімічних впливів. Вони будуються з ухилом для стоку рідини до трапів або збірників і здійснюються непроникними для рідини.

Стіни виробничих і побутових приміщень виконуються відповідним вимогам шумозахисту, теплозахисту, запобігання сорбції; мають обробку з керамічної плитки або олійної фарби, що виключає можливість поглинання й осадження отруйних речовин.
Роздача питної води здійснюється за допомогою фонтанчиків, установлених у середньому з розрахунку один фонтанчик на 75-100 робітників. Температура  питної води при роздачі, відповідно до санітарних норм, не вище 20 оС і не нижче 8 оС. У гарячих цехах постачають робітників підсоленою газованою водою.

Для спускання фекально-господарських і виробничих вод обладнаються каналізаційні пристрої відповідно до діючих нормативних документів СН 245-71, Снип II-30-76.

При роботі з отрутними й токсичними речовинами обов'язкове застосування засобів індивідуального захисту. Для захисту від дії кислот і лугів застосовують захисні фартухи, робочі халати й костюми, виготовлені з гуми, хлорвінілового пластику, прогумованої тканини, брезенту й інших хімічно стійких матеріалів. Для захисту ніг рекомендується використовувати гумові кислотно - щілочностійкі чоботи із внутрішньою текстильною прокладкою й рифленою підошвою з каблуками, а також чоботи.

Для одночасного захисту особи й очей від бризів кислот і лугів використовуються наголовні захисні щитки (типу ЩН і НБХ). Очі захищають напівзакритими або герметичними окулярами (типу ЗПС-80 , ЗПГ-80 , ЗПЗ-80).

Для захисту органів дихання від шкідливих газових пар (крім токсичних) у концентраціях, що не перевищують ГПК більш ніж в 15 разів, рекомендується протигазовий респіратор РУ-60М. 

Для захисту рук від механічних ушкоджень і впливу слабких розчинів кислот і лугів застосовують рукавиці з вовняних, бавовняних тканин з підсилювальними й захисними накладками або без них. 

4.4 Рекомендації з пожежної безпеки

Пожежі у виробничих приміщеннях, де встановлене устаткування, становлять особливу небезпеку, тому що вони поєднані як з матеріальними втратами, так і з відмовою встаткування й обчислювальної техніки, що у свою чергу спричиняє порушення ходу технологічного процесу. Модуль містить у собі горючі матеріали, такі як поліхлорвінілова ізоляція проводів, склотекстоліт, лаки, фарби.

У виробничому приміщенні присутні наступні горючі речовини:

- дерево (столи, двері);

- пластмаса (компоненти ЕРЕ, корпуса й т.п.);

- скловолокна (плати);

- полімери (ізоляція, покриття підлог) і т.д.

Пожежовибуховонебезпека застосовуваних матеріалів наведена в табл. 6.3

Внаслідок наявності пожежонебезпечних матеріалів, відповідно до НАПБ.Б.03.002-2007 виробниче приміщення відноситься  до категорії В.

Можливими джерелами запалювання можуть бути речовини й матеріали, застосовувані в технологічному процесі, ізоляція кабелів і електроустаткування.

Основні причини пожеж технічного характеру:

- порушення технологічного режиму;

- несправність електроустановок;

- незадовільна підготовка установок до ремонту;

- самозаймання матеріалів.

Таблиця 4.3 - Пожежовибухонебезпечність застосовуваних матеріалів

	Матеріал
	Показник небезпеки
	Засоби гасіння

	Каучук синтетичний

(амортизатори встаткування)
	Горюча речовина, виділювані при горінні пари вибухонебезпечні   t запалення 315 оС 

t самозапалювання 374 оС
	Гасити розпиленою водою, піною, порошком ПФ (фосфорно-амонійним) і іншими порошковими засобами, вуглекислотою

	Поліамід (матеріал корпуса  мікросхем)
	Горюча речовина

t запалення 315 оС

t самозапалювання 420 оС

енергія запалювання 200мдж
	те ж


Продовження табл. 4.3
	Матеріал
	Показник небезпеки
	Засоби гасіння

	Полістирол ударноміцний (корпуса ЕРЕ)
	Горюча речовина

t запалення 343 оС

t самозапалювання 486 оС
	те ж

	Склотекстоліт (друковані плати)
	Важкозаймистий 

матеріал, схильний до 
теплового самозаймання

t запалення 285 оС

t самозапалювання 480 оС
	те ж

	Лак електроізоляційний (покриття друкованих плат)
	Горюча речовина

t запалення 141 оС

t самозапалювання 379 оС
	те ж

	 Емалі, ґрунти (захисні й декоративні покриття)
	Легко займисті речовини, пожежовибуховонебезпечні
	те ж

	Олово (пайка ЕРЕ)
	Горюча речовина

t запалення 430 оС

енергія запалювання 80 мДж
	те ж

	Алюміній (радіатори)
	Горюча речовина

t запалення 470 оС

енергія запалювання 0,025 мДж
	те ж


Потенційні причини загоряння:

- загоряння кабелів при дотику їх до перегрітих частин установки;

- перегрів елементів пристрою внаслідок короткого замикання ;

- загоряння проводів за рахунок перевантаження по струму або ушкодження ізоляції;

- іскровий розряд між наелектризованими частинами встаткування;

- іскри від замикання й розмикання ланцюгів електроживлення;

У відповідність із ГОСТ 121.004 - 91 для захисту встаткування при коротких замиканнях для зменшення часу дії використовується система запобігання пожежі:

- запобігання утворення горючого середовища;

- виключення утворення джерел запалювання в горючому середовищі;

- система протипожежного захисту;

- організаційно - технічні заходи.

Протипожежний захист досягається застосуванням автоматичних установок пожежної сигналізації й застосуванням засобів пожежогасіння.

Приміщення обладнується відповідно до “Типових правил пожежної безпеки для промислових підприємств” автоматичною пожежною сигналізацією з димовим вісником фотоелектричного типу ИДФ – М, призначених для виявлення початкової стадії пожежі по появі диму в місці його розташування й видача тривожного сигналу на станцію пожежної сигналізації, причому відповідно до розрахункових даних і параметрами вісника ИДФ – М на площу 9 м2 необхідний один вісник.

Пожежні вісники мають наступні характеристики:

- спрацьовування при зниженні оптичної щільності на 10 %;  
– контрольована зона при висоті установки 4м - 50…100м2;   
- інерційність спрацьовування 30 с;

- фонова освітленість у місці установки 500 лк;

- припустима швидкість повітряного потоку 6 м/с;

- напруга постійного струму живлення 27В;

- споживана потужність 1,5 Вт;

- діаметр 125 мм;

- висота 97 мм;

- маса 0,6 кг;

- термін служби шість років.

У відповідність із ГОСТ 12.4.009 – 89 на 100 м2  площі приміщення необхідно передбачити два вогнегасники. Як первинні засоби пожежогасіння передбачається використовувати:

- один ручний вогнегасник ОУ - 5;

- один повітряно-пінний вогнегасник ОВП - 5;

- азбестова ковдра 1,5 х 2м.

У якості організаційно - технічних заходів рекомендується проводити навчання робочого персоналу правилам пожежної безпеки.

Загальні ВИСНОВКи


У ході виконання дипломного проекту були розглянуті теоретичні основи проектування високошвидкісної РЕА з виконанням вимог електромагнітної сумісності, за допомогою яких було досліджено деякі лінії зв’язку блоку комбінованого БК-2075 і запропоновані методи подолання неузгодженості ліній за допомогою розташування цільних шарів металізації. 


При розгляді основ проектування високошвидкісної РЕА були вивчені важливі відомості про параметри імпульсних сигналів та їх спектральний склад, розглянемо ланцюги з зосередженими та розподіленими параметрам, види реактивностей у ланцюгах та завадостійкість РЕА і класифікацію перешкод.


Були проаналізовані конструкції шарів землі багатошарових структур друкованих плат, напрямки поширення струмів у шарах металізації, конфігурації шарів живлення та землі, проаналізована необхідність наявності захисних доріжок та шарів апаратної землі. 


Також були досліджені механізми виникнення перехресних перешкод та способи їх ослаблення шарами землі та живлення. Детально розглянуто механізми взаємного ємнісного та індуктивного зв’язку.


Запропоновані методи укладання шарів у багатошарових друкованих платах, а також запропонований попередній аналіз для визначення ширини друкованих доріжок, та визначення кількості необхідних шарів. Розглянуто метод укладання шарів для чотирьохшарової, шестишарової та десятишарової друкованої плати.


У розділі аналізу електромагнітної сумісності топології ДБП було запропоновано метод дослідження друкованих плат, та за його допомогою був досліджений блок комбінований БК-2075, а саме його лінії зв’язку UN000008, UN000009, UN000010. Лінія UN000008 була проаналізована на склад перехідних процесів, а лінії UN000009 та UN000010 на склад взаємних перехідних процесів. На кожну досліджуємо лінію було запропоновано методи подолання небажаних коливань виникаючих при перехідних процесах.

Виконано розділ охорона праці дипломного проекту.
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